
#1$2+3 Windows Info-ZIP Unzip Index

Introduction
What is WizUnZip ?
Installing WizUnZip

How To...
Open an Archive File
Show the Archive Comment
Browse Text in the Archive
Extract Files from the Archive
Test Files in the Archive
Exit WizUnZip

Screen Regions
Title Bar
Menu Bar
Toolbar Buttons
ArchiveDirectoryListbox
Status/Display Window
Icon

Error Messages
Error Messages in the Status/Display Window
Error Messages in Dialog Boxes

Glossary
Defined Terms

Product Information
System Requirements
Who is Info-ZIP ?
Copyright and Distribution
Where to Find Info-ZIP Products 
Warranty or Lack Thereof
History
Bugs and Restrictions

1 main_index
2 Help Index
3 index:0005



#4 The Index contains a list of all Help topics available for Windows Info-ZIP Unzip. For 
information on how to use Help, press F1 or choose Using Help from the Help menu.
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#5$6+7What Is WizUnZip ?

WizUnZip stands for Windows Info-ZIP Unzip. WizUnZip is a Microsoft Windows application 
which extracts, tests, and displays files archived in ZIP archive format.

WizUnZip is derived from a co-operative effort by a number of developers collectively known
as Info-ZIP. (See Who is Info-ZIP ?). Info-ZIP's goal is to provide widely-available, non-
commercial archiving tools compatible with Phil Katz's popular DOS application products, 
pkzip and pkunzip. Info-ZIP's counterpart products are called zip and unzip respectively. 
WizUnZip 3.0 can extract files from archives created using pkzip 2.04 or earlier.

The unzip logic of WizUnZip is based on Info-ZIP's product unzip, which has been ported to a 
number of platforms.WizUnZip is essentially unzip with a Microsoft Windows interface and a 
little extra logic to display and extract files. 

In keeping with Info-ZIP's goals, WizUnZip is available on a not-for-profit basis. (See 
Copyright and Distribution.)
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#8$9+10K11 Installing WizUnZip

Install the WizUnZip executable file, WIZUNZIP.EXE, and its associated help file, 
WIZUNZIP.HLP, by copying them into any directory listed in your system's PATH environment
variable. 
Your WINDOWS directory is usually listed there.

Though not necessary for proper operation, the WizUnZip unzipping sound file, 
WIZUNZIP.WAV, may be installed on any directory listed in your system's PATH environment 
variable.
Your WINDOWS directory is usually such a directory.
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#12$13+14Archives Menu

The Archives menu includes commands that let you select or de-select all of the 
ArchiveDirectoryListbox entries as well as commands which operate on the archive (ZIP file) 
itself.

For more information, select an Archives menu command from below.

Select All Files Selects all listbox entries.
Deselect All Files De-selects and unhighlights all listbox entries.
Select Files by Pattern Selects filenames by pattern.
Extract Extracts selected listbox entries
Display Displays selected listbox entries
Test Tests selected listbox entries
Show .ZIP Comment Displays a comment in the .ZIP file
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#15$16+17De-select All Files

This menu item de-selects and unhighlights all entries in the ArchiveDirectoryListbox. 

WizUnZip dims the three buttons {bmc extract.bmp}(Extract),{bmc display.bmp}(Display), 
and 
{bmc test.bmp}(Test).

You may then select one or more entries in the listbox using the pointer or the keyboard. 

Selecting one or more entries in the ArchiveDirectoryListbox causes the buttons to become 
active again. 

Select any of the buttons to operate on the selected entries.

Pressing the F3 key or clicking on the {bmc deselall.bmp} button is a short-cut to de-
selecting all ArchiveDirectoryListbox entries.
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#18$19+20 Select All Files

This menu item selects and highlights all entries in the ArchiveDirectoryListbox. 

WizUnZip activates the three buttons {bmc extract.bmp}(Extract),{bmc 
display.bmp}(Display), and 
{bmc test.bmp}(Test). 

Select any of these three buttons to operate on all selected entries in the archive.

Pressing the F2 key or clicking on the {bmc selall.bmp} button is a short-cut to selecting all 
ArchiveDirectoryListbox entries.
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#21$22+23 Select Files By Pattern

When archives contain a large number of files, you can select the files to be extracted by 
specifying patterns in the filenames. 

This menu item opens the Select Files by Pattern dialog box. It prompts you to enter a 
pattern by which files in the ArchiveDirectoryListbox are selected. 
Your pattern may contain wild card characters such as *, ?, and character lists surrounded by
square brackets.
You may enter multiple patterns, separated by white space, in the edit field.
Choose the Select button to highlight your choices in the ArchiveDirectoryListbox. 
The files can then be extracted, displayed, or tested using any of the three pushbottons. 

You may alternately deselect files in the Archive Directory Listbox by first specifying a 
pattern then choosing the Deselect button.

After making all your selections and deselections, you may wish to close the dialog box by 
selecting the Done button. 

Pressing the F4 key or clicking on the {bmc selpat.bmp}    button is a short-cut to the Select 
Files by Pattern dialog box.
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#24$25+26Status/Display Menu

The Status/Display menu includes commands that let you select or de-select all of the 
ArchiveDirectoryListbox entries or to control the Status/Display Window.

Clear Status/Display Window Clears the contents of the Status/Display 
Window.

Copy Status/Display Window to Clipboard Copies the entire Status/Display Window to the 
Windows clipboard.

Clear Status/Display Window before Displaying Clears the entire Status/Display Window 
before

displaying text.
Don't Prompt to Clear Status/Display Window Optionally lets WizUnZip automatically 

clear 
the Status/Display Window.
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#27$28+29Clear Status/Display Window

This menu item clears the Status/Display Window.

WizUnZip automatically clears your Status/Display Window if its contents would either 
exceed the amount of global memory space available in your system or reach 65535 
characters.

Pressing the Del key is a short-cut to clearing the Status/Display Window.
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#30#31 $32+33Copy Status/Display Window to Clipboard

This menu item copies the entire contents of the Status/Display Window to the Windows 
clipboard.

Currently there is no way to copy a portion of the Status/Display Window to the Windows 
clipboard.

The Control-C key sequence is a short-cut which copies the Status/Display window to the 
clipboard.
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#34$35+36Clear Status/Display Window before Displaying

When selected, this menu item automatically clears    the Status/Display Window before 
displaying text    from the archive file.

When selected, this menu item is checked under the Status/Display menu.

This option stays set until you    change it.
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#37$38+39Don't Prompt to Clear the Status/Display Window before Displaying

When selected, this menu item automatically clears    the Status/Display Window before 
displaying text    from the archive file.
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#40+41$42Menu Bar

WizUnZip's Menu Bar contains the following menus:

File Menu Operates on files and directories
Archives Menu Operates on files within an archive
Status/Display Menu Controls the Status/Display window
View Menu Controls general appearance
Preferences Menu Sets and remembers preferences
Help On-line documentation
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#43$44+45File Menu

The File menu includes the following commands:

Open Archive Opens an archive and lists its directory.
Unzip Archive To Changes the directory into which WizUnZip extracts files.
Copy Archive Copies the archive to a different filename and/or directory.
Move Archive Moves the archive to a different filename and/or directory.
Delete Archive Deletes the archive.
Rename Archive Renames the archive.
Make Directory Creates a directory.
Exit Exits WizUnZip.
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#46$47+48File Menu "Open Archive" Command

If you select the File menu's Open command or click on the button bar's {bmc open-
up.bmp} button, WizUnZip brings up the Open Archive dialog box.

Open Archive Dialog Box

This dialog box lets you select the ZIP archive on which you may perform further operations.
Select the directory in which the ZIP archive is found.
When you select a directory,    WizUnZip lists all of the Zip archives, files with suffix .ZIP, in 
the file listbox.
The File Name field starts out as a template of all the ZIP archives in the directory.

You may select archives with other suffixes using the Files of Type combo box. 
You may select self-extracting .ZIP files, which have the .EXE suffix. 
However, not every file with a .EXE suffix is a self-extracting .ZIP file.
WizUnZip lets you safely attempt to open the file to find out.

Select an archive either by clicking on its filename from the file listbox or by typing its name 
in the File Name edit box.
Select the OK button to put your choice into effect.

Select the Cancel button if you don't wish to open a new ZIP archive.

When you open a ZIP archive, WizUnZip displays the archive contents in the Archive 
Directory Listbox of its main window. 
WizUnZip does not automatically extract the contents.    See Extracting Files from the 
Archive to find out how to extract files.

You may unzip the archive contents either into the directory where the .ZIP file lives or into a
separate directory.
See the File Menu Unzip To Command and the Unzip to Same Directory as .ZIP item under 
the Preferences Menu for more information.
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#49$50+51K52 File Menu "Unzip To..." Command

Selecting this command or clicking on the {bmc unzipto.bmp} button lets you change the 
directory into which WizUnZip extracts entries from the current ZIP archive.
You may extract files into a directory other than the one in which the ZIP archive file resides.

If the    command or button is grayed, you may enable it by toggling the Unzip to Same 
Directory as .ZIP item under the Preferences Menu.

If you don't select a destination directory, WizUnZip assumes you wish to extract files into 
the same directory as the ZIP archive.
The "Unzip To..." command produces the Unzip To Dialog Box.

Unzip To Dialog Box

This dialog box lets you browse and select a destination directory for unzipped archive 
entries.

The Directories listbox shows where WizUnZip places extracted files.

You may browse the directory tree by repeatedly selecting directories from the Directories 
listbox.

To automatically change to the selected directory the next time you start WizUnZip, select 
the Save as Default checkbox.

Select the OK button to save the new directory as the one to which WizUnzip extracts files.    
The new destination directory appears on the title bar.

Select the Cancel button to return to the directory displayed on entry.

NOTE:
The Drives listbox shows all drives in the system. 
However, you won't be able to select write-protected drives such as CD-ROM drives and 
certain network drives.
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#53$54+55File Menu Copy Archive Command

Once you have opened an archive, this command lets you make a copy of it. See Opening an
Archive.

Copy Archive Dialog Box
Selecting this command opens the Copy Archive dialog box in which you enter the name to 
be given to the copy.

You may also select a different directory for the copy of your archive file.    The destination 
directory must be writable (i.e. not on a CD-ROM or write-protected network drive.)

The {bmc copy.bmp} button is a shortcut to the Copy Archive dialog box.
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#56$57+58File Menu Move Archive Command

Once you have opened an archive, this command lets you move the archive file.

Move Archive Dialog Box
Selecting this command opens the Move Archive dialog box in which you enter the new 
name to be given to the archive file.

You may also select a new directory for your archive file. The destination directory must be 
writable (i.e. not on a CD-ROM or write-protected network drive.)

The {bmc move.bmp} button is a shortcut to the Move Archive dialog box.
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#59$60+61File Menu Delete Archive Command

Once you have opened an archive, this command lets you delete the archive file.

The command opens a dialog box which offers you a chance to change your mind.

If you decide to continue, WizUnZip closes the current archive and deletes the file from your 
disk.

The {bmc trash.bmp} button is a shortcut to this operation.
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#62$63+64File Menu Rename Archive Command

Once you have opened an archive, this command lets you rename the archive file.

Rename Archive Dialog Box
Selecting this command opens the Rename Archive dialog box in which you enter the new 
name to be given to the archive file.

You may also select a new directory for your archive file. The destination directory must be 
writable (i.e. not on a CD-ROM or write-protected network drive.)

The {bmc rename.bmp} button is a shortcut to the Rename Archive dialog box.
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#65$66+67File Menu Make Directory Command

This command lets you create a new directory.

You may wish to create a new directory before extracting the contents of a ZIP archive.

This menu command takes you to the Make Directory Dialog Box.

Afer creating a new directory, you may wish to enter it using the Unzip Archive To command.

The {bmc makedir.bmp} button is a shortcut to the Make Directory Dialog Box.
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#68$69+70Make Directory Dialog Box

This dialog box allows you the create a new directory or subdirectory on your system.

You may wish to create a subdirectory into which you can extract files from an archive.

The dialog box lists the current directory in which the files will be extracted.    

In the field entitled "Enter path for new directory" you may specify any of:

1) a subdirectory under the current directory, e.g.

mynewdir

2) an absolute path on the current drive, e.g.

\mynewdir

3) or, a full pathname, including drive, e.g.

c:\mynewdir

Select the OK button or just hit the Enter key to apply your selection.
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#71$72+73File Menu Exit Command

This command takes you out of WizUnZip. 
To find out other ways to exit WizUnZip, see Exiting WizUnZip.
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#74$75+76K77 Exiting WizUnZip

You may exit WizUnZip by any of the following methods:
1) typing Alt-F4, 
2) selecting Exit from the File Menu, or 
3) selecting Close from WizUnZip's system menu, or
4) by clicking on the {bmc exit.bmp} button.

You may safely exit WizUnZip at any time without fear of losing data.
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75 Exiting WizUnzip
76 procedures:100
77 exiting



#78$79+80K81Preferences Menu

The Preferences menu lets you specify how WizUnZip handles directories, whether or not 
WizUnZip should overwrite existing files during extraction,    what WizUnZip does when you 
select one or more files in the ArchiveDirectoryListbox, and to where WizUnZip extracts files 
from the archive.

For more information, select any of the following items:

Recreate Directory Structure Lets you retain directory structure or not.
Save Options Automatically saves source and destination directories

Extract Options Controls filename conflicts.

Translate LF to CR-LF Translates LF character to CR/LF character pair.
Translate Filename Spaces to Underscore maps space characters in filename to underscore
Unzip to Same Directory as .ZIP Controls whether you unzip in .ZIP or other 
directory.

The following three items let you define the action taken when you double-click on a file in 
the ArchiveDirectoryListbox: 

Listbox Selection Extracts File Double click extracts entry.
Listbox Selection Tests File Double click tests entry.
Listbox Selection Displays File Double click displays text file.

Sound Options Selects sound at start or end of operation.

Show Toolbar Help                          Displays Toolbar Help or not.

WizUnZip saves your option selection permanently until you replace it with another.
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#82$83+84K85Recreate Directory Structure

During file extraction this option specifies whether or not WizUnZip re-creates subdirectories 
saved within the archive. 

When this option is active, a checkmark appears beside its menu item.

When this option is active, WizUnZip extracts, preserving the directory structure present in 
the archive.

When this option is not active, WizUnZip extracts the files from subdirectories listed in the 
archive into the parent directory.

WizUnZip saves the setting of this option in your WIZUNZIP.INI file until you change it again 
through the menu.
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83 Recreate Directory Structure
84 options:010
85 directory;extracting



#86$87+88K89Save Options

Determines whether to save source and destination directories.
Always Save Unzip To Dir
Always Save Unzip From Dir

86 HELPID_SAVE_OPTIONS
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#90$91+92K93Always Save Unzip To Dir

When checked, this option directs WizUnZip to save the last Unzip To directory selected, to 
be used as the initial Unzip To directory the next time you run WizUnZip.

90 HELPID_SAVE_UNZIP_TO_DIR
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#94$95+96K97Always Save Unzip From Dir

When checked, this option directs WizUnZip to save the last directory in which an archive file
was opened, to be used as the initial directory in which to search for an archive the next 
time you run WizUnZip.

94 HELPID_SAVE_UNZIP_FROM_DIR
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#98$99+100 K101Extract Options

During extraction, WizUnZip may encounter files in the destination directory which have the 
same names as those WizUnZip would extract from the archive.    
The following options help WizUnZip handle conflicts:

Never/Always Overwrite Existing Files
Extract Only Newer Files
Prompt to Overwrite Existing Files

98 HELPID_EXTRACT_OPTIONS
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#102$103+104K105Always/Never Overwrite Existing Files Option

When you choose this option, WizUnZip automatically overwrites each existing file that it 
finds during extraction. 
WizUnZip places a check mark beside the menu item to show that the option is in force.

WizUnZip saves the setting of this option in your WIZUNZIP.INI file until you change it again 
through the menus.

Overwrite Existing File Dialog Box

When you don't choose the Overwrite Existing Files option, WizUnZip prompts you with a 
dialog box for each existing file that it would replace during extraction. The dialog box 
prompt gives you five alternatives.    You may:

1) skip the file without extracting it (the default),
2) overwrite the file,
3) overwrite the file and all others in this operation,
4) overwrite none of the files in this operation,
5) rename the conflicting file.

If you select 3) or 4), the Overwrite Existing Files Dialog Box won't appear for the rest of the 
operation if any more files should conflict with existing files.
The Overwrite Existing Files Dialog Box has no effect on the more permanent Overwrite 
Existing Files Option. 
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#106$107+108K109 Encrypted Files

WizUnZip can extract files from an encrypted archive, but you must first know the password.

Encrypted File Dialog Box

When you first attempt to extract, display, or test a file from an encrypted archive, WizUnZip
displays the Encrypted File dialog box, prompting you for the password with which the 
archive was encrypted.    

As you type the password in the Password field, WizUnZip echoes the password as a series 
of asterisks. 

If you enter the correct password, WizUnZip proceeds with the operation.    

If you enter the wrong password, WizUnZip gives you two more chances to enter the right 
password then cancels the operation.

If you forget the password or do not know the password of an encrypted archive, there is no 
way to extract, display, or test the archived files using WizUnZip.

106 HELPID_PASSWORD
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#110$111+112K113 Extract Only Newer Files

This option directs WizUnZip to automatically overwrite a file in the destination directory 
with a newer file from the ZIP archive if their names match. 

This option is active only if its menu item is checked.

WizUnZip saves the value of this option until you change it again. 

110 HELPID_EXTRACT_ONLY_NEWER
111 Extract Only Newer Files
112 options:024
113 extracting



#114$115+116K117 Prompt to Overwrite Existing Files

When active, this option directs WizUnZip to prompt you about overwriting a file in the 
destination directory with a file from the ZIP archive if their names match. 

This option is active only when its menu item is checked.
Selecting this option disables both the Never/Always Overwrite Existing Files option and the 
Extract Only Newer Files option

WizUnZip saves the value of this option until you change it again.

114 HELPID_PROMPT_TO_OVERWRITE
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#118$119+120K121Translate LF to CR-LF

Choose this option only if you are extracting text files from a UNIX or similar computer and 
wish to translate them into the format used by DOS.    
In UNIX text file format, lines of text are separated by a linefeed character. 
Lines of text within DOS files are typically separated by the two characters:carriage return, 
linefeed.

Do not choose this option if you are extracting a binary file.    
Since WizUnZip can't tell the difference between text and binary files, you have to decide 
when to use it.    
In general, don't choose this option unless you're sure you need it.

WizUnZip places a check mark beside the menu item to show that the option is in force.    
The setting you choose stays in effect until you toggle it.
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#122$123+124K125Translate Filename Spaces to Underscore

Choose this option if you want WizUnZip to translate space characters in a filename to 
underscores during extraction.

Space characters in filenames are typically not used in 16-bit versions of Windows.

A checkmark signals that this option is active.

The setting you choose stays in effect until you toggle it.

122 HELPID_SPACE_TO_UNDERSCORE
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#126$127+128K129Unzip to Same Directory as .ZIP

Choose this option only if you want WizUnZip to always extract the contents of the ZIP 
archive in the same directory as the ZIP archive.    
This option saves having to set the extraction directory separately. 

When WizUnZip is set to unzip in the same directory as the ZIP archive, WizUnZip disables 
and grays the File Menu "Unzip To..." Command.

When you do not select this option, WizUnZip enables the File Menu "Unzip To..." Command, 
and you may select the destination directory.

WizUnZip places a check mark beside the menu item to show that the option is in force.    
The setting you choose stays in effect until you toggle it.

WizUnZip's title bar always shows the name of the directory into which it extracts regardless
of the option's setting.
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#130$131+132K133Listbox Selection Extracts File

When this option is active, double-clicking on a ArchiveDirectoryListbox entry extracts the 
selected entry from the archive and logs the outcome in the Status/Display Window.

130 HELPID_LB_EXTRACT
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#134$135+136K137Listbox Selection Displays File

When this option is active, double-clicking on a ArchiveDirectoryListbox entry displays the 
entry in the Status/Display Window. 

134 HELPID_LB_DISPLAY
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#138$139+140K141Listbox Selection Tests File

When this option is active, double-clicking on a ArchiveDirectoryListbox entry tests the entry
and displays the results in the Status/Display Window. 
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#142$143+144K145Sound Options

This entry leads to a dialog box in which you choose the sound that WizUnZip emits either 
before or after the action (i.e. extract, test or display entries) completes. 
If WizUnZip detects that the system can play a wave, you may specify the name of a wave 
file which WizUnZip plays either before or after the operation. 
WizUnZip includes a default wave file, WIZUNZIP.WAV, which contains an unzipping sound. 

Regardless of whether your system can play wave files, you can configure WizUnZip to emit 
a beep on completion.

The Browse option lets you search for .WAV files on your system.

The Play option plays whichever .WAV file is shown in the Sound Name or File edit field.
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#146$147+148K149 Show Toolbar Help

This option from the Preferences Menu controls whether to display Toolbar Help. 

The choice toggles each time this entry is selected.

When a checkmark appears beside the entry, toolbar help is active.

Your choice stays in effect until you change it.

146 HELPID_SHOW_BUBBLE_HELP
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#150$151+152K153View Menu

The View menu directs WizUnZip to display the archive contents in either Long Format or 
Short Format.

WizUnZip places a check mark beside the menu item corresponding to the 
ArchiveDirectoryListbox format which is currently selected.

You may also modify the relative sizes of the ArchiveDirectoryListbox and    the 
Status/Display Window by selecting Maximize Archive Directory Listbox, Maximize 
Status/Display Window, or Split.

WizUnZip places a check mark beside the menu item corresponding to the screen layout 
which is currently selected.

150 HELPID_VIEW
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#154$155+156K157Long Format

In long format WizUnZip's Archive Directory Listbox shows:

the file length in Kbytes before archiving,
the ZIP method of archiving: e.g. deflating, imploding, storing, shrinking, reducing.
the file size in Kbytes within the archive,
the compression ratio,
the file modification date,
the file modification time,
the 32-bit cyclic redundancy check value, used for integrity checking,
the file name.
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#158$159+160K161Short Format

In short format WizUnZip's Archive Directory Listbox shows:

the file length in Kbytes before archiving,
the file modification date,
the file modification time,
the file name.

158 HELPID_SHORT
159 Short Format
160 format:020
161 format



#162$163+164K165Maximize Status/Display Window

This menu item maximizes the Status/Display Window so that it covers the Archive Directory
Listbox.    This makes it easier for you to browse a file displayed from the archive.

You can restore the Status/Display Window by selecting the Restore entry from its system 
menu, by double-clicking its maximize/minimize icon in its upper right-hand corner, or by 
Selecting the Split menu item under the View menu.
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#166$167+168K169Split

This menu item restores the Archive Directory Listbox and Status/Display Window to their 
original sizes.
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#170$171+172K173Maximize Archive Directory Listbox

This menu item maximizes the Archive Directory Listbox, covering the Status/Display 
Window. This makes it easier for you to view archives with many entries.

You can restore the Archive Directory Listbox by selecting the Split menu item under the 
View menu.

170 HELPID_MAX_LISTBOX
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#174$175Glossary

DOS
FTP
Internet
Toolbar Help
UNIX
Win32s
ZIP archive
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176#177$178K179DOS

The DOS operating system popular on IBM-compatible personal computers.
It's either running or emulated on your PC right now.
DOS usually is short for MS-DOS, a trademark of Microsoft.
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180#181$182K183FTP

File Transfer Protocol. A protocol for transferring files through the Internet.
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184#185$186K187Internet

A data network connecting many universities, corporations, and government institutions.
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188#189$190K191Toolbar Help

A type of on-screen help which appears when your mouse cursor passes over one of the 
buttons of the toolbar. 
A summary of the functions of the button appears in a rectangle below the button bar.
The help message disappears as soon as your mouse cursor is moved away from the button.
Also called balloon help.
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192#193$194K195Win32s

Extensions to Windows 3.1 and Windows 3.11 which allow some 32-bit applications to run in 
a 16-bit environment.
The Win32s extensions are not installed by WizUnZip and must be obtained separately.
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196#197$198K199UNIX

The UNIX operating system is popular on multi-user open computer systems.    Unix is a 
trademark of X/Open.
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200#201$202K203ZIP archive

A ZIP archive is a collection of files stored within a single file in the format implemented by 
Phil Katz's products pkzip and pkunzip as well as Info-ZIP's products zip and unzip.

ZIP archive files typically have the suffix .ZIP. 

WizUnZip is compatible with archives created by pkzip version 2.04 and earlier.
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#204#205 $206+207K208Browsing Text in the Archive

To browse one or more files within the archive, do the following:

First open the archive, see Opening an Archive File,

Next select the files you wish to view, using the ArchiveDirectoryListbox. 

Finally display the contents by doing of the following:

1) clicking on the Display Button {bmc display.bmp},
2) typing Control-D, or
3) selecting the Display option under the Archives Menu.

The selected entries will be displayed in the Status/Display Window which can be scrolled 
using the horizontal and vertical scroll bars.

Alternately, you may use the Preferences menu to let you automatically display a file 
whenever you select its entry in the ArchiveDirectoryListbox.    
To do so, select the Listbox Selection Displays File. from the Preferences menu.    
Whenever you double-click on a entry in the ArchiveDirectoryListbox, WizUnZip displays the 
entry's contents in the Status/Display Window. 
WizUnZip saves this setting in your WIZUNZIP.INI file until you change it.

WizUnZip cannot distinguish between text and binary data files, so it is possible to display a 
binary data file into the Status/Display Window. 
WizUnZip assumes that the files it displays in the Status/Display Window are in the PC 
manufacturer's OEM codepage, which WizUnZip translates to the ANSI character set. 
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#209#210 $211+212K213Extracting Files from the Archive

To extract files from an archive, do the following:

First open the archive, see Opening an Archive File,

Next select the files you wish to extract, using the Archive Directory Listbox . 

Finally start the extraction by doing any one of the following:
a) clicking on the Extract button {bmc extract.bmp}
b) typing Control-X, or by
c) selecting the Extract item under the Archives Menu.

WizUnZip extracts the files, placing them in the directory shown on the title bar. 
The Status/Display Window lists the names of the files as they are extracted.

A successful extraction displays status messages similar to these:

inflating: FILE1.DAT
inflating: FILE2.DOC
inflating: FILE3.EXE
inflating: FILE4.TXT

Alternately, you may use the Preferences menu to let you automatically extract a file 
whenever you double-click on an entry in the ArchiveDirectoryListbox.    To do so, select the 
Listbox SelectionExtracts File. from the Preferences menu.    
Now when you double-click on an entry in the Archive Directory Listbox, WizUnZip extracts 
it. WizUnZip saves this setting in your WIZUNZIP.INI file until you change it.
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#214#215 $216+217K218Testing Files in the Archive

To test files in the archive for integrity, do the following:

First open the archive, see Opening an Archive File,

Next select the files you wish to test, using the Archive Directory Listbox.

Finally start the test by doing any of the following:
1) clicking on the Test button {bmc test.bmp},
2) typing Control-T, or 
3) selecting the Test option under the Archives Menu.

Alternately, you may use the Preferences menu to let you automatically test a file whenever 
you double-click on an entry in the ArchiveDirectoryListbox.    To do so, select Listbox 
Selection Tests File  from the Preferences menu.    Afterwards, when you double-click on an 
entry in the Archive Directory Listbox, WizUnZip will test it. WizUnZip saves this setting in 
your WIZUNZIP.INI file until you change it.

WizUnZip tests the files, listing the file names and results as they are tested in the 
Status/Display Window. 

A successful test displays messages similar to these:

testing: FILE1.DAT OK
testing: FILE2.DOC OK
testing: FILE3.EXE OK

No errors detected in compressed data of C:\MYARCHVE.ZIP.
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#219$220+221K222Opening an Archive File

Before you can operate on a ZIP archive, you must open it. 
WizUnZip only operates on archive files in .ZIP format. .ZIP files are created either by Phil 
Katz's PKZIP program or by Info-ZIP's ZIP program. 
ZIP files are identified by their .ZIP suffix.

You may open a .ZIP file by any of the following methods:

1) passing its name to WizUnZip when you start WizUnZip or,

2) using WizUnZip's File Menu Open Command or,

3) dragging the filename and dropping it onto the WizUnZip window, or 

4) clicking on the {bmc open-up.bmp} Open an Archive (.ZIP) File button

For easy browsing and extraction of .ZIP files, you may find it useful to associate the 
suffix .ZIP with WizUnZip in the Windows' Registry.

When the archive file has been successfully opened, its name appears in WizUnZip's title 
bar. 
From that point forward, WizUnZip's ArchiveDirectoryListbox and button operations apply to 
the open file. 
WizUnZip can open only one .ZIP file at a time. 
It is not necessary to close or save the file before exiting WizUnZip.
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#223$224+225K226Showing the Archive Comment

Some ZIP archive files contain a readable comment.
 
If you have opened an archive which has a comment, the Show .ZIP Comment button {bmc 
comment.bmp} will be active.
 
If the archive has no comment, then the Show .ZIP Comment Button will be grayed.    

You may display the comment by any of the following:

1) selecting the Show .ZIP Comment button with the mouse,
2) typing Control-S, or 
3) selecting the Show .ZIP Comment item under the Archives Menu.

The comment will be copied into the Status/Display Window where it may be scrolled using 
the scroll bars or the standard Windows navigation keys. 
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#227$228+229K230 Archive Directory Listbox

When you open a ZIP archive, WizUnZip displays the archive's directory in the Archive 
Directory Listbox at the top of WizUnZip's main window. The contents may be displayed in 
either Long Format or Short Format using the View Menu. The format of the listbox entries 
will be familiar to users of Phil Katz's PKUNZIP program or Info-ZIP's UNZIP program.

The Archive Directory Listbox is an extended, multiple-selection listbox.
This means you may select multiple files by clicking the mouse on a given item and 
dragging the mouse downward through the listbox.
You may also press the Control key and click on listbox individual items to make a 
cumulative list.
To select or de-select all files in the listbox at once, use the Edit Menu.

After selecting the files on which you wish to operate, you can Browse Text in the Archive, 
Extract Files from the Archive, or Test Files in the Archive.

You may extract, display, or test files directly from the listbox by double-clicking on the 
entries in the listbox. To define which action WizUnZip takes when you double-click on an 
entry, use the Preferences Menu. The push-button which corresponds to the listbox double-
click action is surrounded by a thicker frame.

Background Color

The background color of the Archive Directory Listbox heading and total area is the Windows
Disabled Text color.
You can change your system's Disabled Text color using the Windows Control Panel.
Be careful! If you set your system's Disabled Text color to the same color as regular text 
(e.g. black), you won't be able to see the headings and totals above and below the Archive 
Directory Listbox.
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#231$232+233K234 Toolbar Buttons

Just below WizUnZip's menu bar lies its button bar, containing the bitmaps shown below. 
To see what function one of WizUnZip's buttons performs, click on the corresponding button 
below:

{bml open-up.bmp} Open an Archive (.ZIP) File

{bml extract.bmp} Extract a File from the Archive

{bml display.bmp} Display a Text File within the Archive

{bml test.bmp} Test the Integrity of Files in the Archive

{bml comment.bmp}Show .ZIP Comment

{bml copy.bmp} Copy the Archive File

{bml move.bmp} Move the Archive File

{bml rename.bmp} Rename the Archive File

{bml trash.bmp} Delete the Archive

{bml makedir.bmp}Make a Directory

{bml selall.bmp}Select All Files in Archive

{bml deselall.bmp}Deselect All Files in Archive

{bml selpat.bmp}Select Files by Pattern in Archive

{bml clrstat.bmp}Clear Display/Status Window

{bml copystat.bmp}Copy Status/Display Window to Clipboard

{bml unzipto.bmp}Change "Unzip To" Directory

{bml list.bmp}Maximize Archive Directory Listbox

{bml split.bmp}Split Window between Listbox and Display/Status 

{bml status.bmp}Maximize Archive Directory Listbox

{bml exit.bmp}Exit WizUnZip

{bml help.bmp}WizUnZip Help
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#235$236+237K238 Status/Display Window

At the bottom of WizUnZip's main window is the Status/Display window, in which WizUnZip 
displays three types of information from the archive:

1) a record of file extraction and file testing (see Extracting Files from the Archive),
2) text files to browse (see Browsing Text in the Archive),
3) comments (see Showing the Archive Comment).

The Status/Display window may be scrolled horizontally or vertically using either the mouse 
or standard Windows navigation keys.

You can maximize the Status/Display window within WizUnZip's main window by clicking on 
the Status/Display window's maximize box or by selecting the Maximize entry from the 
Status/Display window's system menu.    When maximized, the Status/Display window covers
the listbox.

You can restore the maximized Status/Display window to its normal size by clicking on the 
Status/Display window's maximize box again or by selecting the Minimize entry from the 
Status/Display window's system menu.

You can hide the Status/Display window by selecting Maximize Archive Directory Listbox 
from the View Menu.    To show the Status/Display window, select Split from the View menu.

You can clear the Status/Display window using the Clear Status/Display Window menu item 
from the Edit Menu or by typing the Del key.    The Status/Display window automatically 
clears itself to make room for more information when either of the following happens:

1) the number of characters in the buffer reaches 65535, or
2) your system does not have enough global memory to store more data.
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#239$240+241K242 Title Bar

The title bar shows which ZIP archive is currently open and into which directory WizUnZip 
extracts archive entries.

If no ZIP archive is open, the title bar contains the message (No ZIP File) in the file name 
field.
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#243$244+245K246 Icon
The WizUnZip icon's title includes the name of the current archive file name. 
If no ZIP archive is open, the title contains the text (No ZIP File).

The WizUnZip icon starts out as a fully zipped zipper.

After extracting the first file, the WizUnZip icon changes into an unzipped zipper.

That's as close as WizUnZip comes to snappy graphics and animation.

The icon artwork is by Becky Cobb.
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#247Becky Cobb

"No one can do
      What Becky can do
In just thirty-two
      By thirty-two."

247 term_becky



#248$249+250Error Messages in the Status/Display Window

This section describes some of the error messages which can appear in the Status/Display 
Window.

End-of-central-directory signature not found.    Either this file is not
          a zipfile, or it constitutes one disk of a multi-part archive.    In the
          latter case the central directory and zipfile comment will be found on
          the last disk(s) of this archive.
This error means that the opened file is either not in ZIP archive format or is a corrupted ZIP 
file.    Check the suffix of the file. This error might occur if you transferred the archive across 
a network as an ASCII file rather than as a binary file. At any rate, WizUnZip can't decipher 
it.

error: can't open zipfile [ filename ]
This message appears if the archive file has been moved or deleted after having been 
opened in WizUnZip.

error:    expected central file header signature not found (file #n).
This error means that the opened file is either not in ZIP archive format or is a corrupted ZIP 
file.    Check the suffix of the file. This error might occur if you transferred the archive across 
a network as an ASCII file rather than as binary file. At any rate, WizUnZip can't decipher it.

Expanding: filename    status
Exploding: filename    status
Extracting: filename    status
Inflating: filename    status
Testing:filename    status
UnShrinking:filename    status
These messages occur during extraction or testing. During extraction they indicate which 
compression technique was employed to archive the file named filename.    The status value 
can be either 

OK,    which means success, 

or

Bad CRC xxxxxxxx    (should be xxxxxxxx), which means the file is corrupted in the 
archive,

where xxxxxxxx is a hexadecimal number.

Fatal write error
This message might appear if the disk had filled up while extracting a file.

filename    unknown compression method
This indicates that WizUnZip cannot extract the given file. The cause is possibly due to a 
corrupted archive or the file was stored using a technique designed after this version of 
WizUnZip.

warning:    didn't find end-of-central-dir signature at end of central dir.
This error indicates that the opened file is either not in ZIP archive format or is a corrupted 
248 HELPID_MSGWIN_ERRORS
249 In the Messages Window
250 errors:010



ZIP file.    Check the suffix of the file. This error might occur if you transferred the archive 
across a network as an ASCII file rather than as a binary file. 

warning:    filename too long--truncating
This error might appear when extracting a file generated on a system other than DOS. The 
name exceeds DOS's 8.3 format.



#251$252+253Error Messages in Dialog Boxes

This section describes error messages which may appear in a Windows message box.

A write error has occurred. Perhaps the disk is full. Continue ?
Appears during extraction. It typically occurs if the disk to which you are extracting runs out 
of free space. Files may erroneously appear to have CRC errors during extraction in this 
case.    It typically does no good to continue.

Cannot open filename
Appears in the Open a ZIP File dialog box if you specify a file that doesn't exist.
Can also appear if you specify a file which does not exist when starting up WizUnZip with a 
filename argument.

Can't change directory to <directory name>!
Appears before or after extraction if WizUnZip has been configured to change to or return to 
a non-existent directory.

Clearing Messages window to make room for more information.
Appears if the Status/Display Window buffer becomes full or otherwise cannot grow.

johnny__.yuu. Cannot access this file. Please verify security privileges on the 
network drive.
This message box appears if you try to select a write-protected drive, such as a CD-ROM 
drive, from the Unzip To... dialog box.
(See File Menu "Unzip To..." Command.)

This archive contains too many files for WizUnZip to list them all! 
This appears if the archive contains many files and the data required to list those files and 
their attributes exceeds a Windows internal limit of 65K characters.
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#254$255+256K257 System Requirements

WizUnZip is released as both a 16-bit version and a 32-bit version.    You can tell which 
version you are running by opening WizUnZips About Box.

Feature WizUnZip-16 WizUnZip-32
Windows 3.1 supported unsupported
Windows 3.11 supported unsupported
Windows 3.X + Win32s supported supported
Windows 95 supported supported
Windows NT 3.X supported supported
Sound optional optional*
Disk space required 300K bytes 245K bytes
Memory required minimum** minimum**

*WizUnZip-32 running under Windows 3.X + Win32s does not support sound. In all other 
combinations WizUnZip supports sound as long as a sound card and an appropriate driver 
are installed.

**WizUnZip has no memory requirements above the minimum required to run your version 
of Windows.
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#258$259+260K261 Who is Info-ZIP ?

This is a partial list of contributors to Info-ZIP UnZip and the code upon which it is based.
Many, many others have also contributed, and if you are among them, please let us know.
Aside from the Info-ZIP digest archives, we have not kept very good track of who contributed
what.

Mark Adler decryption, inflate, explode, funzip code; misc. casts
Steve Alpert VMS rms.h bugfix
Glenn Andrews MS-DOS makefiles; prototyping bugfix; bogus main() fix
Andrei Arkhipov Solaris 2.x package files
Joel Aycock descrip.mms bugfix
Eric Baatz Borland version() info
Charles Bailey VMS_SEVERITY fix; VMSWILD () extension
Audrey Beck "Where" file info for AOL OS/2 forum
Mike Bernardi Unix makefile entry; CIX uploads
James Birdsall extract.c/makefile/NT stuff, etc.; awesome beta tester
Allan Bjorklund in misc.c
Denise Blakeley Unix makefile entry
Wim Bonner original OS/2 port; Unix makefile entry
Paul Borman BSD/386 (BSDI) fixes; Unix makefile entry
Rodney Brown stdin-/dev/null bugfix; VMS error levels
John Bush first full Amiga port; FileDate; Amiga fixes; etc.
Valter Cavecchia Unix makefile entry
Andrey Chernov BSD 4.4 utime fix
John Cowan mods to original match.c; other stuff?
Frank da Cruz xxu.c, on which original mapname.c was based
Bill Davidsen -q(q); mapname stuff; envargs; Xenix stuff; etc.
Matt "Doc" D'Errico AIX stuff, Unix makefile entry
Kim DeVaughn Unix makefile entry
Arjan de Vet various things, but I don't remember exactly what...
Frank Donahoe djgpp v2.0 makefile entry
James Dugal ZMEM stuff; unshrink bugfix; file perms stuff; etc.
Jim Dumser -z stuff; umask bugfixes; opendir/Borland fix; etc.
Mark Edwards mapname.c, misc.c fixes; Unix makefile entry
Gershon Elber Unix makefile entry
Bruce Evans Unix makefile entry
David Feinleib Windows NT port
David Fenyes Unix makefile entry
Greg Flint Unix makefile entry
Jeffrey Foy OS/2 stuff(?); [CP/M]
Mike Freeman VMS GCC makefiles; VMS fixes; etc.
Kevin Fritz Borland bugfixes; etc.
Jean-loup Gailly decryption code; ReadByte replacement; much 
nagging :-)
Forrest Gehrke Unix makefile entry
Tim Geibelhaus Unix makefile entry
Henry Gessau flush/Fwrite/outcnt fixes; new NT port
Christian Ghisler inflate tweaks
Filip Gieszczykiewicz Unix makefile entry
Paul Gilmartin work-around for systems with broken catman/makewhatis
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Hunter Goatley VMSCLI interface; VMS help/RUNOFF; list maintainer
Michael Graff Unix makefile entry
Richard H. Gumpertz Unix makefile entry
Steve Hanna Macintosh stuff
Mark Hanning-Lee docs corrections, Unix Makefile fixes, "check" target
Robert Heath Windows port (WizUnZip 1.0 & 2.0)
Dave Heiland new usage screen
Ron Henderson -a bugfix
Chris Herborth new Atari port; Atari fixes
Phil Howard Unix makefile entry
Joe Isuzu Unix makefile entry
Aubrey Jaffer pixel, v7 targets
Graham Jenkins Sequent Dynix/ptx bugfix
Peter Jones Unix makefile entry
Larry Jones ZMEM stuff; unimplod bugfix; etc.
Warren Jones MKS bugfix
Kjetil Jørgenson Makefile bugfix; OSF/1 fix; NetBSD fix; djgpp v2 mods
Bruce Kahn DOS floppy detection?; Unix makefile entry
Bob Kemp NOTINT16 rewrite; Unix makefile entry
J. Kercheval filmatch.c, on which second match.c was based
Paul Kienitz continuing general Amiga porting; Aztec C support; ASM
Mike Kincer AIX "ps2" bugfix
David Kirschbaum mapname port; general-purpose meddling; Python jokes
Paul Klahr Regulus port
Jim Knoble Turbo C++ makefile fix
Alvin Koh Borland C++ bugfixes
Karel Kubat Linux strncasecmp bugfix
Bo Kullmar -z code; bugfixes: umask, do_string, BSD time; etc.
Michael Lawler Borland version() info; process.c string fix
Johnny Lee Macintosh port; Win3.1 port; far strings/small model
Alexander Lehmann makefile.tc bugfix; MS-DOS mapname() bugfix
Marty Leisner man pages fonts; install-target fixes
Daniel Lewart AIX stuff; compiler warnings
John Limpert Unix makefile entry
Hogan Long Borland preprocessor bugfix
Mike Long Unix Makefile installation bugfix
Warner Losh in misc.c
Dave Lovelace Data General AOS/VS port
Tony Luu NT timezone bugfix
Igor Mandrichenko vms.c; many improvements and VMS modifications
Javier Manero file_io.c bugfix; MS-DOS version() bugfix
Paul Manno makefile.tc fixes
Fulvio Marino revised UnZip and ZipInfo man pages; Makefile entry
Carl Mascott original Unix port
Rafal Maszkowski Convex unzip.h fixes; Unix makefile entry
Eberhard Mattes handler() bugfix
Peter Mauzey Unix makefile entry
Scott Maxwell version.h; OS/2 DLL port [coming soon!]
Bob Maynard 16-bit OS/2 pathname bugfix
Randy McCaskile Unix makefile entry
Gene McManus -o code
Joe Meadows file.c, on which VMSmunch.c (timestamps) was based
Jason Merrill Sequent patches
Tom Metro corrupted-zipfile handler bugfix
Ricky Mobley Unix makefile entry



Navin Modi Unix makefile entry
Paul Motsuk Borland _rtl_chmod() fix
Anthony Naggs MS-DOS error handling stuff
NIIMI Satoshi Human68k port
Mike O'Carroll early OS/2 stuff
"Moby" Dick O'Connor Unix makefile entry
Thomas Opheys Watcom C stat() bugfix
Humberto Ortiz-Zuazaga Linux port; permissions bugfix; missing declarations
Rafael Pappalardo Convex CRYPT bugfix; Convex Makefile entry, useful info
Trevor Paquette Unix makefile entry
Keith Petersen Pyramid fixes; former Info-ZIP list maintainer
Alan Phillips Unix makefile entry
Art Pina C Set/2 crypt.c optimization bug
Piet W. Plomp nice fix for msc_dos Makefile target
Clint Pulley Unix makefile entry
Antonio Querubin, Jr. descrip.mms (VMS makefile)
Alistair Rae Encore preprocessor bugfix
Stephen Ritcey vms/README installation correction
David Robinson MSC 6.0 stat() bugfix
Jochen Roderburg floating-point BSD4_4 fix
Greg Roelofs maintainer/principal author; ZipInfo; unshrink; etc.
Kai Uwe Rommel "real" OS/2 port; many new compilers; bugfixes; etc.
Paul Roub first self-extracting code
Steve Salisbury Win32 fixes; dual-mode SFX instruct.; variable INBUFSIZ
Georg Sassen Amiga DICE compiler port
Jon Saxton date formats, OS/2 fixes
Tom Schmidt Unix makefile entry
Hugh Schmidt VMS stuff
Martin Schulz original Atari port, symlinks bugfix
Charles Scripter various bug reports and bugfixes
Chris Seaman Unix time stuff
Richard Seay MS-DOS Quick C makefile
Alex Sergejew file_io.c, stat(), Makefile fixes; Down Under jokes :-)
Jim Seymour Borland OS/2 fixes
Mark Shadley Unix -X bugfix, FGETCH fix
Timur Shaporev inflate optimizations
Fred Smith Coherent 4.0 fixes
Samuel H. Smith original unzip code (Pascal and C) for MS-DOS
Jim Spath zipinfo -T century bugfix
Christian Spieler performance tweaks; VMS and other fixes
Cliff Stanford file_io.c umask bug
Jack Stansbury DEC Alpha NT makefile fix
Dan Statkus OS/2, MS-DOS mapname() ASCII 255 bugfix
Jim Steiner Unix makefile entry
Richard Stephen Unix makefile entry
Wayne Stewart "Where" file MS-DOS correction
Brian Tillman "Where" file VMS correction
Onno van der Linden many fixes, esp. Intel Unix and 386 DOS
Jim Van Zandt one of original man pages
Geraldo Veiga Pyramid strrchr/rindex
Erik-Jan Vens Unix makefile entry
Antoine Verheijen new Mac port; Mac fixes; MTS/EBCDIC stuff; etc.
Rich Wales former Info-ZIP moderator and zip guy; MKS stuff
Frank Wancho original TOPS-20 port
Paul Weiss unzipsfx bugfix



Paul Wells original Amiga port for SAS/C and Lattice C (?)
Eugene (Mike)White Win-32 & Win-16 ports (WizUnZip 3.0)
Rainer Wilcke HP/UX termios bugfix; man-page fixes
Greg Woods man-pages bugfixes
Mark Wright Netware 3.11 NLM port
Randy Wright Unix makefile entry
Meiwei Wu open() return bugfix
Martin Zinser VMS .hlp file for unzipsfx; MAKESFX.COM command file



#262$263+264K265 Copyright and Distribution

===========================================
The following copyrights are claimed on portions of the UnZip source code.
Further comments are at the bottom.
===========================================
Copyright in unzip.c, originally from unzip version 1.2 (?):

* Copyright 1989 Samuel H. Smith;    All rights reserved
*
* Do not distribute modified versions without my permission.
* Do not remove or alter this notice or any other copyright notice.
* If you use this in your own program you must distribute source code.
* Do not use any of this in a commercial product.

-------------------------------------------------------------------------------

Copyright in misc.c, applying to UpdateCRC() and crc_32_tab[]:

COPYRIGHT (C) 1986 Gary S. Brown. You may use this program, or code or tables 
extracted from it, as desired without restriction.

-------------------------------------------------------------------------------

Copyright in vms.c, distributed with UnZip versions 4.2 and later:

* Copyright (C) 1992 Igor Mandrichenko.
* Permission is granted to any individual or institution to use, copy,
* or redistribute this software so long as all of the original files
* are included unmodified, that it is not sold for profit, and that
* this copyright notice is retained.

-------------------------------------------------------------------------------

Additional copyright information:

BILF (distributed with the VMS stuff) is copyrighted by Rahul Dhesi, but it is freely 
distributable.

The functions extract_or_test_files() and store_info() in extract.c, do_string() and 
return_VMS() in misc.c, VMS version of echo() in file_io.c, and find_end_central_dir() in 
unzip.c, were written by Greg Roelofs and subsequently modified by many others via Info-
ZIP. I do not claim a copyright on these routines, but I do ask that no one else do so 
either, :-) and that anyone using them in other programs note their source.

The function decrypt_member() in extract.c and the password functions in file_io.c were 
written by Mark Adler, as were the inflate.c and explode.c modules.

The function mapped_name() in mapname.c was written by David Kirschbaum, based on the
XXU program by Frank Da Cruz.

262 HELPID_DISTRN
263 Copyright and Distribution
264 product_info:020
265 Copyright and Distribution



The module match.c was written by J. Kercheval and modified by David Kirschbaum for use 
in UnZip.

Original notes from unzip 2.0a by Carl Mascott, cmascott@world.std.com (these are only the 
modifications which seem still to exist):

* 12/14/89 C. Mascott 2.0a adapt for UNIX
* don't pre-allocate output file space
* implement -t, -v, member file specs
* buffer all input
* fix "Bad CRC" msg: good/bad CRCs were swapped
* check for write error on output file

Most of the remaining routines have contributions from all of us, and show it. :-)

===========================================

Info-ZIP Policy on Copying

There are currently three explicit copyrights on portions of UnZip code (at least, of which 
Info-ZIP is aware):    the original Sam Smith      copyright on unzip 2.0, upon which Info-ZIP's 
UnZip 3.0 was based;      Igor Mandrichenko's copyright on his routines in vms.c; and Greg      
Roelofs' copyright on zipinfo.c and the new version of unshrink.c.      In addition, Mark Adler 
has placed inflate.h, inflate.c, explode.c      and funzip.c into the public domain; i.e., these 
files may be used      without any restrictions beyond those of simple courtesy (credit where    
it's due).    All of these are discussed immediately below; the remaining code is covered by 
an implicit copyright under US law.    Frequently Asked Questions regarding (re)distribution of
Zip and UnZip are near the end of this file.

There are no(?) known patents on any of the code in UnZip.    Unisys claims a patent on LZW 
encoding and on LZW decoding _in an apparatus which performs LZW encoding_, but a 
careful reading of the patent strongly suggests that a lone decoder (as in UnZip's unshrink.c)
is not covered.    [Does this also apply to the IBM Miller-Wegman patent?]      [Is RLE used?    Is 
Huffman covered by anything?    Is any decoding technology covered by anything?]
__________________________________________________________________________

The original unzip source code has been extensively modified and      almost entirely 
rewritten (changes include random zipfile access rather than sequential; replacement of 
unimplode() with explode(); replacement of old unshrink() with new (unrelated) unshrink(); 
replacement of output routines; addition of inflate(), wildcards, filename-mapping, text 
translation, ...; etc.).    As far as we can tell, the only remaining code which is substantially 
similar to Mr. Smith's is that in the file unreduce.c, which now by default is NOT compiled.    
The following copyright applies to unreduce.c:

          * Copyright 1989 Samuel H. Smith;    All rights reserved
          *
          * Do not distribute modified versions without my permission.
          * Do not remove or alter this notice or any other copyright notice.
          * If you use this in your own program you must distribute source code.
          * Do not use any of this in a commercial product.

Regarding the first stipulation, Mr. Smith was tracked down in southern California some years
back [Samuel H. Smith, The Tool Shop; as of mid-May 1994, (213) 851-9969 (voice), (213) 
887-2127(?) (subscription BBS),
      71150.2731@compuserve.com]:



"He says that he thought that whoever contacted him understood that he has no objection 
to the Info-ZIP group's inclusion of his code. His primary concern is that it remain freely 
distributable, he said."

Despite the fact that our "normal" code has been entirely rewritten and by default no longer 
contains any of Mr. Smith's code, Info-ZIP remains indebted and grateful to him.    We hope 
he finds our contribu-tions as useful as we have his.

      Note that the third and fourth stipulations still apply to any company which wishes to 
incorporate the unreduce code into its products; if you wish to do so, you must contact Mr. 
Smith directly regarding licensing.

The following copyright applies to the new version of unshrink.c, distributed with UnZip 
versions 5.2 and later:

          * Copyright (C) 1994 Greg Roelofs.
          * Permission is granted to any individual/institution/corporate
          * entity to use, copy, redistribute or modify this software for
          * any purpose whatsoever, subject to the conditions noted in the
          * Frequently Asked Questions section below, plus one additional
          * condition:    namely, that my name not be removed from the source
          * code.    (Other names may, of course, be added as modifications
          * are made.)    Corporate legal staff (like at IBM :-) ) who have
          * problems understanding this can contact me through zip-bugs...

      The remaining code was written by many people associated with the
      Info-ZIP group, with large contributions from (but not limited to):
      Greg Roelofs (overall program logic, ZipInfo, unshrink, filename
      mapping/portability, etc.), Mark Adler (inflate, explode, funzip),
      Kai Uwe Rommel (OS/2), John Bush and Paul Kienitz (Amiga), Antoine
      Verheijen (Macintosh), and Hunter Goatley (more VMS).    See the file
      CONTRIBS in the source distribution for a much more complete list of
      contributors.    As noted above, Mark Adler's inflate.[ch], explode.c
      and funzip.c are in the public domain, and everything which isn't
      otherwise accounted for is implicitly copyrighted by Info-ZIP.    In
      other words, use it with our blessings, but it's still our code.
      Thank you!

I Place My Portion in the Public Domain

The Info-ZIP developers have chosen not to copyright unzip.
I, Robert A. Heath, am the author of the Microsoft Windows interface version of UNZIP, which
I call WizUnZip. 
I place the portion which I wrote in the public domain. 
I give you my permission to distribute my portion without condition. (It's free!    No charge!)
You may make derivative works from the source. 

Johnny Lee: Ditto. ;-) 

Eugene (Mike) White: I have chosen to do likewise with my modifications.

The MS Windows-specific sources for WizUnZip 3.0 are archived under wunz30sr.zip on 



popular archive sites.



#266$267+268K269 Where to Find Info-ZIP Products

This information was last updated on 3 August 1995.
__________________________________________________________________________

      Note that some ftp sites may not yet have the latest versions of
      Zip and UnZip when you read this.    The latest versions, including
      the crypt sources, always appear in ftp.uu.net:/pub/archiving/zip
      (and subdirectories thereof) first.

      IF YOU FIND AN ERROR:    please let us know!    We don't have time to
      check each and every site personally (or even collectively), so any
      number of the sites listed below may have moved or disappeared en-
      tirely.    E-mail to zip-bugs@wkuvx1.wku.edu and we'll update this file.
__________________________________________________________________________

Info-ZIP's home WWW site is listed on Yahoo and is at:

      http://quest.jpl.nasa.gov/Info-ZIP/

The Zip and UnZip pages have links to most known mirror sites carrying
our source and/or binary distributions:

      http://quest.jpl.nasa.gov/Info-ZIP/Zip.html
      http://quest.jpl.nasa.gov/Info-ZIP/UnZip.html

Source-code archives for Info-ZIP's portable Zip, UnZip, and related
utilities (on some ftp sites, the .zip files for UnZip may have a .zoo
equivalent in Zoo 2.10 format):

      zip201.zip            Zip 2.0.1 (deflation; includes zipnote, zipsplit)
      zip201.tar.Z        ditto, compress'd tar format

      zip11.zip              Zip 1.1 (shrinking, implosion; compatible with PKUNZIP 1.1)
      zip11.tar.Z          ditto, compress'd tar format

      unzip512.zip        UnZip 5.12 (all methods supported; zipinfo, funzip, unzipsfx)
      unzip512.tar.Z    ditto, compress'd tar format

      wunz20sr.zip        WizUnZip 2.0 sources for Windows 3.x; based on UnZip 5.0p1

      zcrypt24.zip        encryption/decryption support (includes zipcloak)

Executables archives (and related files) for Info-ZIP's software; see BBS
section below for special CompuServe (6.3) filenames:

      zip20x.zip            MSDOS executables and docs for zip, zipnote, zipsplit
      zcryp20x.zip        MSDOS encryption executables and docs for zip, zipcloak
      zip201x1.zip        OS/2 1.x (16-bit) executables and docs (no encryption)
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      zip201x2.zip        OS/2 2.x (32-bit) executables and docs (no encryption)
      zip201c2.zip        OS/2 2.x (32-bit) executables and docs (with encryption)
      zip201xN.zip        WinNT/Win95 executables and docs (no encryption)
      zcr201xN.zip        WinNT/Win95 executables and docs (with encryption)
      zip201-vax.zip    VMS exes (VAX) and docs
      zip201-axp.zip    VMS exes (Alpha) and docs
      zip201x.lha          Amiga executables and docs

      unz512x.exe          MSDOS self-extracting executable (16-bit unzip, ..., docs)
      unz512x3.exe        MSDOS self-extracting executable (16-, 32-bit unzip, docs)
      unz512x1.exe        OS/2 1.x (16-bit) self-extracting executables and docs
      unz512x2.exe        OS/2 2.x (32-bit) self-extracting executables and docs
      unz512xN.exe        Windows NT (and Win95) self-extracting Intel exes and docs
    (unz512xN-mips.exe, unz512xN-axp.exe:    Windows NT exes/docs for MIPS & Alpha)
      unz512x-vax.exe VMS self-extracting executables and docs for VAX unzip
      unz512x-axp.exe VMS self-extracting executables and docs for Alpha unzip
      unz512x.lha          Amiga executables and docs for unzip
      unz512x.tos          Atari self-extracting executables and docs for unzip
      unz512x.hqx          Macintosh BinHex'd executables and docs for unzip
    (unz512x.tar.Z or .gz:    Unix exes/docs for Solaris 2.x, SCO Unix or Linux,
                                      depending on directory/location)

      UnzpHist.zip        complete changes history of UnZip and its precursors

      wunz20x.exe          WizUnZip 2.0 executable/docs for Windows & NT 3.1, OS/2 2.1
      wunl20x.exe          same as wunz20x.exe, plus two DLLs for Win 3.0 and OS/2 2.0

The latest from PKWARE (the guys who started it all):

      pkz204g.exe          MS-DOS PKZIP/PKUNZIP 2.04g (self-extracting archive)
      pkz110eu.exe        MS-DOS PKZIP/PKUNZIP 1.1 (self-extracting)
      pkz206-2.exe        OS/2 PKZIP/PKUNZIP 2.06 (IBM internal only; same as 2.04g)
      pkz102-2.exe        OS/2 PKZIP/PKUNZIP 1.02 (self-extracting)

Third-party software which incorporates Info-ZIP code:

      OS/2:    Warp 3.0 BonusPak, FileJet, The UnZip Shell, zipmeister (PMZip),
          ZipFly(?)
      NT:    WinZip
      Windows:    Nico Mak WinZip, InnerMedia DynaZIP DLL, NewVision Zip[Shell] Pro,
          Flashpoint ZIP Navigator, Z (port of ZipInfo; z101.zip)
      MS-DOS:    FileJet
      Macintosh:    ZipIt
      generic Unix:    lzpip103.zip

Third-party software which uses (or can use) Info-ZIP software:

      OS/2:    Zip Control, ZiPMe, Workplace Shell UnZip (WUZ), Drop and Zip,
          Archive Front End, Archive Manager, Archive Viewer, File Manager/2,
          FileStar/2, ZTreeBold, PMZipper, simple zipshell, HyperView, XBBS-OS/2,
          LiveWire
      MS-DOS:    SHEZ archiver shell
      NeXTStep 3.x:    Opener

ftp sites for the US-exportable sources and executables:



      NOTE:    Look for the Info-ZIP file names given above (not PKWARE or third-
      party stuff) in the following locations.    Some sites like to use slightly
      different names, such as zip-2.0.1.tar.gz instead of zip201.tar.Z.    In
      the case of some comp.sources.misc archive sites, directories may be used
      (zip201/part01.Z, ..., zip201/part11.Z, zip201/patch01.Z, etc.).

      ftp.uu.net:/pub/archiving/zip                [THIS MIRRORS THE INFO-ZIP HOME SITE]
      src.doc.ic.ac.uk:/packages/zip              [THIS MIRRORS THE INFO-ZIP HOME SITE]
      unix.hensa.ac.uk:/mirrors/uunet/pub/archiving/zip

      ftp.cmdl.noaa.gov:/aerosol/doc/archiver/{all,dos,os2,mac,vax_alpha}
      oak.oakland.edu:/SimTel/msdos/{zip,windows3}        [AND OTHER SIMTEL MIRRORS]
      oak.oakland.edu:/pub/misc/{unix,vaxvms}
      garbo.uwasa.fi:/{unix,pc}/arcers                                  [AND OTHER GARBO MIRRORS]
      ftp-os2.cdrom.com:/pub/os2/archiver
      ftp-os2.nmsu.edu:/archiver
      ftp.informatik.tu-muenchen.de:/pub/comp/os/os2/archiver
      sumex-aim.stanford.edu:/info-mac/util
      ftp.wustl.edu:/pub/aminet/util/arc                            [AND OTHER AMINET MIRRORS]
      atari.archive.umich.edu:/pub/Archivers (?)              [AND OTHER UMICH MIRRORS]
      lpuds.oea.ihep.su:/ ... ?

ftp sites for the encryption and decryption sources and/or executables:

      NOTE 1:    Non-US users, please do NOT ftp from the US sites (US
      regulations and all that).    Likewise, US users, please do not
      ftp from the European sites (it's not illegal, but it sure is
      a waste of expensive bandwidth).

      NOTE 2:    Some sites may carry both encryption and non-encryption
      executables with slightly different names; for example, zip201c2.zip
      instead of zip201x2.zip ("c" == crypt version).    Other sites may
      include *only* the encryption-related executables (zip and zipcloak)
      in a second archive (e.g., zcryp20x.zip).

      From the US:
            wuarchive.wustl.edu:/mirrors/garbo.uwasa.fi/arcutil
            ftp.uu.net:/pub/archiving/zip

      Outside the US:
            garbo.uwasa.fi:/pc/arcutil
            ftp.inria.fr:/system/arch-compr
            ftp.informatik.tu-muenchen.de:/pub/comp/os/os2/archiver
                  (mail server at ftp-mailer@informatik.tu-muenchen.de)

            ftp.win.tue.nl:/pub/compression/zip/...
            ftp.uni-erlangen.de:/pub/pc/msdos/utilities/zip/...

ftp sites for VMS-format Zip and UnZip packages (sources, object files and
executables, no encryption/decryption--see also "Mail servers" section below):

      ftp.spc.edu [192.107.46.27] and ftp.wku.edu:

      [.MACRO32]AAAREADME.TXT



      [.MACRO32.SAVESETS]UNZIP.BCK    or    UNZIP.ZIP    (if already have older version)
      [.MACRO32.SAVESETS]ZIP20.ZIP    (to be renamed to ZIP.ZIP in next release)

To find other ftp sites:

      The "archie" ftp database utility can be used to find an ftp site
      near you (although it always seems to find old versions...).    If
      you don't know how to use it, DON'T ASK US--check the Usenet groups
      news.announce.newusers or news.answers or some such, or ask your
      system administrator (or just RTFM :-) ).

UUCP sites:

      uunet!~/pub/archiving/zip/ ...

Bulletin boards (commercial and otherwise):

      Sources, MS-DOS executables:
            CompuServe IBMPRO forum, Library 10, Data Compression (unz512.zip,
                  sources; unz512.exe, self-extracting executables and docs)
            CompuServe (ZiffNet) PBSUTIL forum and Public Brand Software BBS
                  [US, membership required; V.32 line, (317) 856-1490]
                  (unz512.zip, sources; unz512.exe, self-extracting exes and docs)
            America Online OS/2 Forum, Free Uploading area; also Top Picks lib-
                  rary, File/Disk Utilities library, and OS/2 1.x library (do key-
                  word search via ctrl-K:    FILE SEARCH on "INFOZIP")
            FidoNet node 1:124/2113, Lunatic Fringe [Richardson, Texas; BBS
                  (214) 235-5288; sysop john.stewart@lunatic.com; complete mirror
                  of Info-ZIP home site]
            FidoNet node 1:246/74, Metal Shoppe BBS [Windsor, Ontario; CLink
                  node 911:6510/0; BBS (519) 256-0278; sysop rakey@cyberspace.net
                  (Ray Akey); micro-based files but no Unix/VMS/NT stuff]
            Drealm Conference System [London, UK; V.22bis, subscriber lines
                  to V.32bis, etc.; (+44) 81 568 2204]
            Compulink Information eXchange (CIX) [London, UK; BBS 14.4 and 28.8
                  lines, (+44) 181 390-1244, -1255 and -9787; executables in "the
                  filepool," sources in free_software/sources]

      Windows sources and executables:
            CompuServe ZENITH forum (wunzip.zip, WizUnZip exe + libs for
                  Win 3.x, NT, OS/2 2.x)
            CompuServe CRAFTS forum (wunz20.exe, WizUnZip bare executable
                  for Win 3.1, NT, OS/2 2.1)

      OS/2 executables:
            CompuServe OS2USER forum (zip201.zip and unz512.exe, OS/2 16-
                  and 32-bit exes and docs)

      Amiga executables:
            BIX in AMIGA files section (perform keyword search on "info-zip")
                  [requires account; telnet bix.com, or "C BIX" via local Sprint
                  X.25 PAD, or dial direct in US at (617) 491-5410]

Mail servers:



      If you don't have anonymous FTP capability, you can mail one
      of the following commands (in the body of an e-mail message) to
      listserv@vm.ecs.rpi.edu or listserv@vm1.nodak.edu in order to
      get a copy of the source code via e-mail:

            /pdget mail /pub/misc/unix/unzip512.tar.Z uuencode
            /pdget mail /pub/msdos/zip/unzip512.zip uuencode
            /pdget mail /pub/msdos/zip/zip201.zip uuencode

      The older, pseudo-TOPS-20 style also works:

            /pdget mail pd:<misc.unix>unzip512.tar.Z uuencode
            /pdget mail pd:<misc.unix>zip201.zip uuencode

      To get the encryption source by e-mail, send the following commands
      to ftp-mailer@informatik.tu-muenchen.de:

            get /pub/comp/os/os2/archiver/zcrypt24.zip
            quit

      To get the VMS Zip/UnZip package by e-mail, send the following
      commands in the body of a mail message to mxserver@wkuvx1.wku.edu
      (the "HELP" command is also accepted):

            SEND UNZIP
            SEND ZIP20                      <-- will change to plain "ZIP" in next release
            SEND FILESERV_TOOLS

      To get Atari executables by e-mail, send a message to 
      atari@atari.archive.umich.edu for information about the mail server.
__________________________________________________________________________

_



#270$271+272Warranty or Lack Thereof

WizUnZip's authors make no promises express or implied on the suitability of this software 
product for any particular purpose. 

All responsibility for use of WizUnZip lies with the user.

Eugene (Mike) White
Robert A. Heath

270 HELPID_WARRANTY
271 Warranty
272 product_info:030



#273$274+275History

Unzip Versions
Version Date Contributor(s)
v1.2 15 Mar 89 Samuel H. Smith
v2.0 9 Sep 89 Samuel H. Smith
v2.x fall 1989 many Usenet contributors
v3.0 1 May 90 Info-ZIP (DPK, consolidator)
v3.1 15 Aug 90 Info-ZIP (DPK, consolidator)
v4.0 1 Dec 90 Info-ZIP (GRR, maintainer)
v4.1 12 May 91 Info-ZIP
v4.2 20 Mar 92 Info-ZIP (zip-bugs subgroup; GRR, maint.)
v5.0 21 Aug 92 Info-ZIP (zip-bugs subgroup; GRR, maint.)

WizUnZip versions
Date Version Description
Jan. 27, 1992 1.0 Original Release.
Apr. 26, 1992 1.1 Fixes problem in LF to CR,LF 

mapping. Renamed "Translate LF 
to CR,LF" option to "Translate 
CR,LF to LF". 
Release of source.

June 30, 1992 1.2 Updated to Unzip 5.0 source and MS Windows 3.1
Added drag-drop, sped up zip operations, and
hiding status window.

August, 1992 1.3 Tidied up bugs in 1.2 version.

May 21, 1993 2.0 Release of WizUnZip 2.0 Beta 1.
Aligned with unzip 5.0p1,
for pkzip 2.04 compatibility.
Fixed many bugs in Windows interface.
Changed "Translate CR,LF to LF" feature
back to "Translate LF to CR,LF.".
New features: configurable "unzip to" 
directory, select files by pattern, 
play wave on completion, copy status
window to clipboard, offers self-
extracting archives as a choice when
opening a file. Moved initialization 
data to WIZUNZIP.INI. 
Thanks to Richard
Hartman for some good ideas!

July 4, 1993 2.0 General release of WizUnZip 2.0.

January 1, 1996 3.0 General release of WizUnZip 3.0
- Modified to compile under Borland C compiler.
- Allow compilation for either Win-16 or Win-32.
- Added support for encryption.
- Added toolbar help.
- Added various options to display.
- Added ability to copy, move, rename, delete archive files,
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    and create directories.



#276$277+278Help Overview

WizUnZip offers three varieties of help:

WizUnZip Help Help specific to WizUnZip
Using Windows Help How to Use Windows Help in General
About WizUnZip... Version and Author
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#279$280+281WizUnZip Help

Standard Help
WizUnZip has standard Windows help, accessed by typing the F1 key.    This method takes 
you to WizUnZip's top help index. You may use the mouse or keyboard to select lower-level 
topics or to simply browse.

Context Help
WizUnZip also has context help by which you can hit Shift-F1, producing the 
question-mark/arrow cursor. You may then select any of WizUnZip's menu items using the 
mouse or the keyboard.    Context help takes you directly to the help screen associated with 
the desired menu item.

Toolbar Help
WizUnzip provides Toolbar Help when you pause the mouse cursor over one of the buttons 
on WizUnZips toolbar.    Toolbar help can be enabled or disabled, using the Show Toolbar Help
option under the Preferences Menu 
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#282$283+284Using Windows Help

This menu entry takes you to the standard introduction on using Windows help.
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#285$286+287K288 About WizUnZip...

The about box tells:

1) whether you are running the 16-bit or the 32-bit version,

2) the program release number, and 

3) information about the authors.
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#289$290+291K292Bugs and Restrictions

Here are a few bugs and restrictions in WizUnZip, along with some workarounds.

Archive Directory Listbox holds up to 64K bytes of data.
This problem is signaled by a Message Box which signals that the listbox has run out of 
space.    This occurs in both WizUnZip-16 and WizUnZip-32. 
Switching to the Short Format can help if the file directory is barely big enough to fit.

Open Dialog Box Can't Distinguish Between Self-extracting .EXE's and 
Ordinary .EXE's
When listing self-extracting files, the Open dialog box lists all .EXE files regardless of whether
they are self-extracting .ZIP files.    
If you open the file and receive the "End-of-central-directory signature not found" message, 
you may assume the file is not a self-extracting .ZIP.

Status/Display Window Displays Windows ANSI Character Set
When displaying a .ZIP file comment in the Status/Display Window, WizUnZip maps the data 
into the ANSI Character Set.
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